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Chapter 1. Introduction 

1.1. @promt Personal 8.0 Translation System  

@promt Personal 8.0 translation system is one of the software products released by the PROMT 
company. 
The @promt 8.0 product line is a new generation of machine translation software. It has unique 
linguistic customization capabilities, which ensure high-quality translation of documents, e-mail 
messages, Web pages and ICQ messages. The @promt Personal 8.0 software allows you to translate 
texts from major European languages (depending on the software package purchased).  
@promt Personal 8.0 is a lite version of the translation system which is intended to be used in a small 
office or at home. Along with low requirements to computer resources, it provides you with all 
necessary possibilities for customizing the translation. 
The @promt Personal 8.0 software runs under Windows Vista, Windows XP, and Windows 2000. 
The @promt Personal 8.0 software provides the following features: 

• coherent, morphologically, syntactically and semantically adequate translation; 
• translation of documents in DOC, RTF, HTML, and TXT formats; 
• translation of Web pages directly in Internet Explorer and Mozilla Firefox; 
• translation functions that are embedded in Adobe Acrobat and Adobe Acrobat Reader 4.x-8.x 

(translation of PDF files); 
• high-functionality tools to improve the quality of translation, such as specialized dictionaries 

and topic templates created by PROMT company for various subject areas; tools to create user 
dictionaries;  

• translation of the Windows Clipboard contents; synchronous translation of the keyboard input 
in any Windows application; 

• Text-to-Speech functionality. 
@promt Personal 8.0 includes the following applications and modules: 

• PROMT Editor Lite, a simpler version of the translation editor that can automatically 
translate the Windows Clipboard contents and text typed in any Windows application; 

• PROMT Extensions Manager, a module that enables and disables translation in external 
applications;  

• PROMT for Internet Explorer, a module that translates Web pages in Microsoft Internet 
Explorer 5.x-7.x; 

• PROMT for Mozilla Firefox, a module that allows you to translate Web pages in Mozilla 
Firefox;  

• PROMT for Acrobat, the module that is used to translate PDF files in Adobe Acrobat and 
Adobe Acrobat Reader 4.x—8.x; 

• PROMT for ICQ, a program that translates ICQ messages; 
• PROMT Dictionary Installer, a program that enables you to install specialized dictionaries 

and topic templates. 
 
In addition, @promt Personal 8.0 software can include specialized dictionaries and topic templates. 
You can buy additional specialized dictionaries. 

1.2. About this User’s Guide  

This User’s Guide forms part of the documentation set. It describes the @promt Personal 8.0 system 
and how to work with it. This Guide does not explain how to work with Windows OS, as this 
information is already widely available.  
Chapter 2 shows how to install @promt Personal 8.0, as well as specialized dictionaries and topic 
templates. 
Chapter 3 describes @promt Personal 8.0 applications.  
Chapter 4 discusses @promt Personal 8.0 dictionaries.  



 

Chapter 5 shows how to use topic templates to provide high-quality translation of texts with similar 
vocabulary and syntactic structures. 



 

1.3. Help and Support 

 

1.3.1. Registration 

Please fill in the registration card and send it to the PROMT company. The registration gives you the 
right to purchase the new versions of @promt products at a considerable discount. The information 
that you give in the card will be stored in the PROMT technical support database. This will help the 
technical support specialists to give you quick and accurate answers to your questions and to inform 
you about @promt Personal 8.0 updates and upgrades. 

1.3.2. Technical Support 

If you encounter problems when working with the program, please contact the PROMT technical 
support department by telephone, fax or e-mail (the contact information is provided on the registration 
card). Please give the following details: 

• the license number of your @promt Personal 8.0 product; 
• the directions of translation your @promt Personal 8.0 system supports and the specialized 

dictionaries you use; 
• the hardware specifications, such as processor type, RAM size, available hard disk space, 

network settings; 
• the software used, such as Windows version, installed service packs, localization, and regional 

settings; 
• a description of the problem and what you were doing when the problem occurred; 
• how you have attempted to solve the problem; 
• the exact text or a screenshot of the error message, if there was any. 

You should be at your computer when you call for support. 
 



 

Chapter 2. Installation and Removal 
 

2.1. System Requirements  

• IBM PC-compatible computer with a Pentium 500 MHz, or higher, processor; 
• 64 МB RAM; 
• monitor and video adapter SVGA, or higher-resolution; 
• CD-ROM drive (for installation); 
• mouse or compatible pointing device; 
• Microsoft Windows Vista, Windows XP Professional with Service Pack SP2 (or higher), or 

Windows 2000 Professional with Service Pack SP3 (or higher); 
• .NET Framework 3.0 (installed automatically by setup program); 
• Microsoft Internet Explorer 5.x or higher. 

The free hard disk space requirements are printed on the product box.  



 

2.2. @promt Personal 8.0 System Installation 

The setup program is a wizard that guides the user step-by-step through the setup process. If 
necessary, you can return to a previous step of the process. At each step you will see a dialog box 
where you can choose installation options and which provides detailed descriptions of the options. 
When you have set all options in the dialog box, click Next. To return to the previous step, click Back. 
You can cancel the installation at any time by clicking Cancel. 
Please close all Windows applications before the installation. 

NOTE: 
To install the program, you need to have administrator rights (i.e., your account must belong to the 
Administrators local group). 

2.2.1. Installation Steps 

To install the software, please perform the following steps: 
1. Start the setup program. 
2. Enter the required information. 
3. Copy the files to the hard disk. 
4. Restart the computer (if necessary). 
5. Activate the product (activation is necessary only for the “Buy-only” products which are 

delivered via the Internet). 

2.2.1.1. Starting the Setup Program and Entering the Required Information 

The setup program is in the root folder of the @promt Personal 8.0 installation CD. Insert  the CD in 
the CD-ROM drive. The setup program will start automatically. If it does not start (because of your 
operating system settings), you should start the setup program manually by using the Run command on 
the Windows main menu. 
To manually start the setup program, follow these steps: 

1. Click the Start button on the Windows taskbar. 
2. Select Run from the Windows main menu. 
3. In the Open text field, type the letter of the CD-ROM drive followed by “:\” and the manual 

installation program name (e.g., d:\Minstall). 
4. Click OK or press Enter. 

Selecting the Interface Language 
If your product allows you to select the user interface language, choose the language from the drop-
down list of the Select Language dialog box and click ОK. 
The Welcome! window shows that the Setup program is started. Then, you can enter the required 
information. 

Product Code  

The Product Code is printed on the first page of the License Agreement. If you enter it incorrectly, the 
program will prompt you to re-enter it. 

License Agreement 

Please read the License Agreement for its terms and conditions. The installation will not continue 
unless you have accepted the terms and conditions of the License Agreement.  

License Number 

The License Number is printed on the first page of the license agreement. If you enter it incorrectly, 
the program will prompt you to re-enter it. 



 

User Details  

You should enter your name and/or your company name. 

Destination Folder 

The default destination folder where the product can be installed is \Program Files\PRMT8 on the hard 
disk on which the operating system is installed. If you want to install the program in a different folder, 
click Change.  

NOTE: 
The Change button may be unavailable if you already have one of the @promt Personal 8.0 products 
installed. In this case, the program will be installed in the same folder. 

Selecting the Installation Type 

The Setup program will offer you a choice of two types of installation: 
• Complete, with all product components installed; 
• Custom, with the opportunity to select the components. 

If you select the Custom option, the Setup program will display the @promt Personal 8.0 components 
tree with applications and directions of translation that are available in your product. Each component 
has its short description and hard disk space requirements in the right pane. To check the free disk 
space on all of your hard disks, click Disk. 

Confirming the Information that you Have Entered  

After you enter all necessary data, the setup program will ask you to confirm the installation of the 
@promt Personal 8.0 software. If you want to review or change any of your installation settings, click 
Back. To proceed, click Install. The third phase of the installation will then begin. 

2.2.1.2. Copying Files to the Hard Disk and Finishing the Installation  

While the files are being copied, the progress bar indicates the progress and the setup program informs 
you of the actions that are being performed. When all @promt Personal 8.0 components have been 
copied and registered in the operating system, the installation will be complete. The setup program 
may ask you to restart your computer. Although you can choose to restart your computer later, we 
strongly recommend that you run any of the @promt Personal 8.0 programs only after restarting. 
If your @promt Personal 8.0 product includes modules that provide translation in external applications 
(see Section 1.1), the setup program will ask you to specify the applications in which you want to 
translate. 
Finally, the setup program will create shortcuts to all installed programs in the PROMT start menu 
group. You can run @promt Personal 8.0 programs from the main menu by selecting All Programs →  
PROMT and then the program that you need. 

2.2.1.3. Activating the Product 

For the @promt Personal 8.0 products, which are acquired via the Internet by “Buy-only” license, you 
will need to fulfill the activation.  
In this case, when you start for the first time any application of the @promt Personal 8.0 product for 
the first time, you will see the window of activation wizard which will suggest you to select one of the 
following modes of activation:  

• Automatic — activation will be automatically performed via the Internet and will not demand 
any additional actions; 

• Manual — provides for receiving the activation code by one of the following ways: 
 by e-mail; 
 on the Web-site of the PROMT company. 

The welcome window of activation wizard contains recommendations for choosing the mode of 
activation and also the detailed information for successful performing the activation. In particular, for 



 

manual activation — the e-mail address and the address of the Web-site of the PROMT company 
where you can get the code of activation.  
After you have selected the mode of activation, follow the instructions of the activation wizard which 
will help you to successfully finish the process.  



 

2.3. Installing and Removing Specialized Dictionaries and Topic 
Templates   

You can install and remove specialized dictionaries and topic templates by using PROMT Dictionary 
Installer. You can start it from the Windows main menu by selecting All Programs →  PROMT  → 
 PROMT Dictionary Installer. 
The setup program is a wizard that leads the user step-by-step through the setup process. When you 
have set all options in the dialog box, click Next. To return to the previous step, click Back. You can 
cancel the installation at any time by clicking Cancel. 
Before the installation begins, please close @promt Personal 8.0 applications and any external 
applications that have embedded translation functions.  

NOTE: 
To install dictionaries, you need to have the administrator rights (i.e., your account must belong the 
Administrators local group).  

When you run the setup program, you can choose the following actions: 
• Install specialized dictionaries  
• Install topic templates 
• Remove specialized dictionaries 
• Remove topic templates 

2.3.1. Installing Specialized Dictionaries  

You can use the following distribution sets to install specialized dictionaries for @promt Personal 8.0:  
• CD: @promt 8.0 Dictionary Collection, Version 8. 

At the beginning of the installation, please enter the license number of your dictionary/collection. The 
number is printed on the registration card. If there is no number, check the corresponding option. 
The setup program will display a dialog box with the list of dictionaries. Select the dictionaries that 
you want to install. At the bottom of the window, you will see the free hard disk space required and 
the total free hard disk space available. 
If you want to install all dictionaries, click Select All. After you click Next, the setup program will 
copy the dictionaries to the hard disk. At the end of this process, the setup program will notify you of 
the successful installation and will offer to install more dictionaries. If necessary, the dictionaries will 
be automatically converted into @promt Personal 8.0 format during the installation. After installing 
each dictionary, the setup program will create the topic template (with the same name as the dictionary 
name) and will attach the installed dictionary to that topic template. 

2.3.2. Installing Topic Templates 

The @promt Personal 8.0 software products can be supplemented by topic templates that have been 
developed in the PROMT company. Topic templates may also contain specialized dictionaries. 
The setup program will ask you for the license number of the topic templates collection (or of a single 
topic template), which is printed on the registration card. If there is no number, check the 
corresponding option. 
The setup program will display the dialog box with the list of topic templates. Select the topic 
templates that you want to install. At the bottom of the window you will see the free hard disk space 
required and the free hard disk space available. 
If you want to install all templates, click Select All. When you click Next, the topic templates will be 
copied to your hard disk. At the end of this process, the setup program will notify you that the 
installation was successful and will offer to install more templates. If the installed templates contain 
specialized dictionaries, the latter will also be installed. 



 

2.3.3. Removing Specialized Dictionaries and Topic Templates 

The program will suggest the following options to you: 
• Remove the selected dictionaries/topic templates of the specified direction. In this case, you 

should specify the direction of translation and choose from the list the dictionaries or 
templates that you want to remove; 

• Remove all the dictionaries/topic templates of the specified direction. All specialized 
dictionaries/templates for the selected direction of translation will be removed; 

• Remove all the dictionaries/topic templates. All dictionaries and templates for all directions of 
translation will be removed. 

Select one of the options and click Remove. The dictionaries/templates will be detached from the 
@promt Personal 8.0 system and physically deleted from the hard disk.  



 

2.4.  Changing and Removing the @promt Personal 8.0 Software 

With the help of the @promt Personal 8.0 Setup program, you can modify the set of the installed 
components or remove the system.  
To do so, follow these steps: 

1. Click Start →  Settings →  Control Panel. 
The Control Panel window will appear. 

2. Double-click the Add or Remove Programs icon. 
The Add or Remove Programs dialog box will appear. 

3. Choose your @promt Personal 8.0 product from the list of installed programs and click 
Change or Remove. 

If you select the Change option, you will be able to install new components and/or remove old 
components. 
If you select the Remove option, the setup program will remove your @promt Personal 8.0 product 
from the computer. During deinstallation, you will be offered the opportunity to save the user data and 
settings, so that the data can be restored at a later time. 



 

Chapter 3. @promt Personal 8.0 Applications 
This chapter describes the applications of the @promt Personal 8.0 software product.  

3.1. PROMT Editor Lite 

PROMT Editor Lite allows you to quickly and easily translate text from the Clipboard or from a file, 
and to obtain simultaneous translation of text that is being typed in PROMT Editor Lite or any other 
Windows application. The PROMT Editor Lite window can be a stay-on-top window or can be 
minimized to a system tray icon. 
To start the program, select Start →  All Programs →  PROMT →  PROMT Editor Lite. 

3.1.1. PROMT Editor Lite User Interface  

PROMT Editor Lite application has a new user interface that is similar to the one in Microsoft Office 
2007 and consists of the following elements: 

• Ribbon 
• Quick Access Toolbar 
• Status bar  
• Working area 

 
Fig. 3.1. PROMT Editor Lite window for quick translation 

All available commands are separated into groups and displayed on the tabs of the Ribbon. Each tab 
corresponds to a specific task (translation, editing, etc.) that is done by the current application. 
To enlarge the working area to work with text, you can minimize the Ribbon by selecting Hide from 
the context menu or double-clicking the active tab. To restore the Ribbon, double-click on any tab 
header or select Hide again. 
To open the File menu that has commands for working with files, click the button in the top left corner 
of the ribbon. 



 

Commands that you use often can be added to the Quick Access Toolbar. By default, the Quick Access 
Toolbar is above the Ribbon. To add a command that you frequently use, right-click the command or 
the command button and select Add to the Quick Access Toolbar from the context menu. 
The Quick Access Toolbar still remains visible while the Ribbon is minimized. This feature enables 
you to easily access commands located there.  
You can move the Quick Access Toolbar so that it is under the Ribbon and closer to the working area. 
 
The status line, which is a horizontal area at the bottom of the application window, displays 
information about the direction of translation and the topic template. To hide the status line, clear the 
corresponding checkbox in the View group on the Tools tab. 
 
The PROMT Editor Lite window consists of two parts (Fig. 3.1). The upper part displays the source 
text. The lower part shows the translation. This is displayed in the window title bar: the document 
name is followed by Source Text or Translated Text. 

3.1.2. Preparing for Translation in PROMT Editor Lite  

Work in PROMT Editor Lite involves the following main operations: 
1. Preparing for translation: selecting the direction of translation and topic template and 

customizing the program options (see Section 3.1.3). 
2. Translating the text. 
3. Enhancing translation quality and re-translating. 
4. Saving the translation results. 

Before you start the process of translation, you should select the direction of translation and the topic 
template and customize the program options which are common for all objects of translation: opened 
documents, text typed on the keyboard or the contents of Clipboard.  
The direction of translation indicates from what language into what language the document is 
translated. For example, if you select the Spanish-English direction of translation, the program will 
consider the source text as Spanish and will translate it into English.  
The topic template is a combination of settings that can be applied to documents that relate to a similar 
topic. For more information about topic templates, see Chapter 5. 
You can specify the direction of translation and the topic template in the General Settings group on the 
Translation tab. Click the appropriate lines in the drop-down lists and select the required values. 

3.1.3. Customizing the common options  

In PROMT Editor Lite, you can customize the program options which are common for all objects of 
translation. These options are the following:  

• on the Tools tab, the Options group: 
 Preserve Formatting — the translation has the formatting features of the source text; 
 Synchronous Translation — text is translated immediately while being typed; 
 Suggest to Save Changes — when an application window changes (because of translation 

of the Clipboard, creating or opening a document), or when you close PROMT Editor 
Lite, the program asks whether you want to save the source text and/or the translation as a 
text file (in TXT or RTF formats); 

 Keyboard Interception — the text that is being typed in external applications appears in 
the upper window as if it were typed in PROMT Editor Lite. 

• on the Tools tab, the View group: 
 Always on Top — the PROMT Editor Lite window stays on top of all other windows; 
 Minimize to SysTray — the PROMT Editor Lite window will reside as a system tray icon 

when you minimize the window or launch the application later. 



 

3.1.4. Working with Translation Functions in PROMT Editor Lite 

 

3.1.4.1. Translating and Saving Files 

You can open files in DOC, RTF, HTML, TXT formats in PROMT Editor Lite. 
When you open a file, its text is displayed in the upper part of the PROMT Editor Lite window. If you 
have selected the Synchronous Translation option in the Options group on the Tools tab, the lower part 
will contain the translation. Otherwise, select Translate Document in the Translate group on the 
Translation tab. 
If you wish to keep the formatting features of the source text in the text of translation, select the 
Preserve Formatting option in the Options group on the Tools tab.  
If necessary, customize the program settings which may improve the translation quality (see 
Section 3.1.5), repeat the translation and save the results of translation. 
You can save both the source text and the translation as a file in RTF or TXT format. 
To save text as a file: 

1. Place the cursor in the upper or lower part of the PROMT Editor Lite window. 
2. Select Save or Save As from the File menu. 
3. Specify the folder, the file name and format in the Save the Source Text As or Save the 

Translation As dialog box. 

3.1.4.2. Translating Text from the Clipboard 

PROMT Editor Lite allows you to translate text from any application which supports copying to the 
Clipboard. The Clipboard translation function allows you to translate quickly and easily: 

• documents that you have opened in other applications; 
• help files; 
• e-mail messages; 
• names of Windows objects (programs, documents or folders). 

To translate a text from Clipboard, follow these steps: 
1. Specify the direction of translation and the topic template in the General Settings group on the 

Translation tab. 
2. Customize the options, which specify the mode of translating Clipboard.  

 Text copied to Clipboard may be translated automatically or manually. To automatically 
translate the changed contents of Clipboard, select the Automatically Translate Clipboard 
checkbox in the Translate group on the Translation tab.  

 If this mode is not selected, choose Translate Clipboard in the Translate group on the 
Translation tab (this command is available, if Clipboard is not empty).  

 You can enable automatic determination of the direction of translation by selecting the 
Automatically Determine Source Language checkbox in the Translate group on the 
Translation tab. 

 You can specify the mode of updating the source text field of the application window. To 
replace the existing source text with the new one automatically, select the Replace 
Previous Text checkbox in the Translate group on the Translation tab. Otherwise, the new 
text will be added to the existing one. 

3. Place the text to the Clipboard.  
To do that, select the text fragment and choose the Copy or Cut command from the 
application’s menu (or press Ctrl+C or Ctrl+X).  

4. Select Translate Clipboard in the Translate group on the Translation tab (if the mode of 
automatic translation of the Clipboard contents is not enabled).  

NOTE: 



 

If the mode of automatic translation of the Clipboard contents is enabled, whenever the 
contents are changed, the PROMT Editor Lite window will appear with the source text and 
translation. 

5. If necessary, edit the translated text and save the results of translation. 

3.1.4.3. Synchronous Translation 

To obtain synchronous translation of the text that you are typing, select the Synchronous Translation 
checkbox in the Options group on the Tools tab. The translation in the lower part of the application 
window will appear straight away as you type in the upper part. The program checks for newly entered 
text approximately each second. 

3.1.4.4. Keyboard Interception 

PROMT Editor Lite can intercept keyboard input from other windows. The text that is being typed in 
them appears in the upper window of PROMT Editor Lite. The program intercepts only plain text 
without any formatting features (font size, color, etc.). 
To enable keyboard interception, select Keyboard Interception from the Options group on the Tools 
tab. The Specify the Window dialog box will appear. 
To enable interception from a specific window only, drag-and-drop the pointer from the Specify the 
window dialog box to the window in which you would like to activate interception and click OK.  
To intercept keyboard input from any window, select the All windows checkbox. 
To disable keyboard interception, select Keyboard Interception again and click Cancel in the Specify 
the Window dialog box.   

NOTE: 
Unlike what occurs when translating the Clipboard, the program does not recognize the direction of 
translation automatically during keyboard interception. 

Using both synchronous translation and keyboard interception may cause an inadequate translation. A 
similar situation is possible if you use keyboard interception when toggling between different 
applications and typing text in each of them. 

3.1.5. Enhancing Translation Quality 

PROMT Editor Lite allows you to considerably enhance the translation quality by performing the 
following actions: 

• attaching dictionaries and changing their priorities; 
• preserving words; 
• using and customizing preprocessors; 
• customizing translation rules; 
• managing translation variants. 

3.1.5.1. Attaching Dictionaries and Changing Their Priorities 

By default, the program uses for translation the General dictionary of the appropriate direction of 
translation. You can enhance the translation quality by attaching specialized and user dictionaries and 
changing their priorities during translation.  
To view the list of dictionaries, select Edit Document Topic in the Document Topic group on the 
Translation Options tab, and then choose the Dictionaries tab in the Document Topic dialog box.  
In the window with the list of dictionaries you may do the following:  



 

• create a list of attached dictionaries — select the dictionary from the Unattached Dictionaries 
list and click the Right arrow or choose Attach from the context menu; 

• change their priorities by using Move Up, Move Down, Move to Top, or the context menu; 
• create or delete a dictionary, view and change its properties (см. раздел 4.2.3); 
• save a dictionary to, or load it from, an archive. 

The list of attached dictionaries is a component of the document topic. The latter can be saved as a 
topic template (see Chapter 5). 

3.1.5.2. Working with the List of Unknown Words  

The text of translation may contain not translated words (not found in the attached dictionaries during 
translation). These words are added to the list of unknown words. 
To open the Unknown Words dialog box, select the appropriate command in the Unknown Words 
group on the Translation Options tab. Next to each word the frequency of its occurrence in the text is 
displayed. 
Using the buttons of this dialog box you can perform the following actions with the words from this 
list:  

• Preserve (add the selected word to the list of words that do not need translation). The Preserve 
a Word dialog box will appear; 

• Delete. Select the words for deleting from the list (by using Ctrl and Shift) and click Delete or 
Delete All (for deleting all words from the list. 

You can save the list of unknown words as a separate text file, which may be later edited or printed. 
To do this, click the Commands button and select Save the List from the drop-down menu, specify the 
file type, enter the name of the file and click ОK.  

3.1.5.3. Preserving the Words That Do Not Need Translation 

Before translation, we recommend that you add the words or collocations that you do not want to 
translate to the list of preserved words. These are usually proper names, abbreviations, special 
designations, etc. Preserved words can be transliterated (i.e., represented by the characters of the target 
language). 

NOTE: 
If you did not preserve words before translation and the system translated the proper names, 
terminology, etc., you can add them to the list of preserved words and retranslate the text. 

The list of preserved words can be saved within a topic template or as a separate file.  
PROMT Editor Lite supports several ways of preserving words or collocations: 

• Place the cursor in the required word or select the collocation. Choose Preserve Word from 
the Preserving group on the Translation Options tab. 

• Place the cursor in the required word or select the collocation, click the right mouse button, 
and choose Preserve Word from the context menu.  

• In the Document Topic dialog box, select the Preserved Words tab and select Add from the 
context menu (or press Ins). 

• If you wish to preserve an unknown word, right-click on the word in the Unknown Words 
dialog box and click Preserve. 

The Preserve a Word dialog box will appear. 
If you specify the semantic class on the Semantic class list, the system will analyze the source 
sentence more correctly. 
If you select the Transliterate checkbox, the source word or collocation will be represented in the 
translation by characters of the target language. 
The list of preserved words is a component of the document topic. The latter can be saved as a topic 
template (see Chapter 5).  
For a detailed description, see Help.  



 

3.1.5.4. Using and Customizing Preprocessors 

You can use preprocessors to manage translation of some text elements. For example, the Standard 
preprocessor can cancel or modify translation of the following constructions: 

• e-mail addresses (e.g., John.Smith@acme.com); 
• URLs (http://www.promt.ru); 
• file and folder names (C:\Windows\System32\Append.Exe); 
• date and time; 
• text fragments that do not need translation.  

The Smileys preprocessor is designed to improve translation of texts with emoticons (“smileys”). 
If you do not use this preprocessor, the above-mentioned constructions may be analyzed and translated 
by the system incorrectly. 
To attach the preprocessors to the current document, open the Preprocessors tab in the Document 
Topic dialog box and select the corresponding checkboxes. 
To modify the settings of a preprocessor, right-click on it and select Customize from the context menu.  
The list of attached preprocessors is a component of the document topic. The latter can be saved as a 
topic template. 

3.1.5.5. Changing Translation Rules 

Translation rules are a set of functions that allow you to manage translation of specific language 
constructions. You cannot do this by changing the dictionary information. 
The list of translation rules depends on the direction of translation. 
Below are examples of translation rules for the Spanish-English direction of translation: 

• Short/long form of verbs (you can choose options: Long form, Short form);  
• Preference for the past tense (you can choose options: Present Tense, Past Tense, Present/Past 

Tense); 
• Quantity of translations for ambiguous pronoun forms (you can choose options: One form, All 

forms). 
For some directions of translation, you can choose the regional variant of the source or target 
languages. 
To change the document translation rules, open the Translation Rules tab or the similar tab in the 
Document Topic window. Every rule is supplied with a detailed commentary. Select the rule that you 
want to change and choose the option from the drop-down list. 
The selected translation rules constitute one of the components of the document topic. The latter can 
be saved as a topic template. 

3.1.5.6. Managing Translation Variants 

A word or collocation in a dictionary may have more than one translation for one part of speech. You 
can improve the translation quality by selecting the appropriate translation variant. 
To see all active translations in the text, select the Show variants of translation checkbox in the 
Document Topic dialog box. The program will display the translation variants in brackets. If you clear 
this checkbox, the program will display only the first translation variant from the list of active 
translations. 

3.1.6. Minimizing PROMT Editor Lite to a System Tray Icon  

You can minimize the PROMT Editor Lite window to an icon in the system tray area on the taskbar. 
To do so, select the Minimize to SysTray checkbox in the View group on the Tools tab. 



 

After this, whenever you minimize the PROMT Editor Lite window or launch the application, the icon 
will appear on the system tray. The icon has a context menu that allows you to translate the Clipboard, 
open the PROMT Editor Lite window, view the program properties and shut down the application. 

3.1.7. Speaking the Text  

With the Microsoft Agent technologies and Text-to-Speech engines used in PROMT Editor Lite, you 
can hear the selected text or the entire document. 

NOTE: 
The components of Microsoft Agent and Text-To-Speech engines for the directions of translation that 
you have purchased are installed automatically during the @promt Personal 8.0 installation. 

To have the text spoken, place the cursor in the source text or the translation or select the required 
fragment, and then select Speak from the Speech group on the Tools tab. To interrupt the process, 
select Stop.  
To customize the text-to-speech features (speed, pitch, and volume), select Customize Parameters of 
Speech from the Speech group on the Tools tab. 



 

3.2. Embedding Translation Functions in External Applications 

@promt Personal 8.0 allows you to translate directly in external applications, such as Internet Explorer 
and Mozilla Firefox web browsers, and Adobe Acrobat.  
To embed these functions in the above-mentioned applications, use the PROMT Extensions Manager 
utility.  
To start the program, click Start →  All Programs →  PROMT →  PROMT Extensions Manager, 
select the checkboxes next to the required applications, and click OK (or Apply, if you do not want to 
close the window). 

NOTE: 
It is necessary that you restart the applications that you have selected to validate the settings. 



 

3.3. PROMT for Internet Explorer 

PROMT for Internet Explorer enables translation of text and search engine queries in Internet Explorer 
5.x—7.x. To embed the translation functions in Internet Explorer, select the corresponding checkbox 
in the PROMT Extensions Manager dialog box (see Section 3.2). 
This will add the PROMT menu to the application's user interface. The menu has translation 
commands and translation options. The main commands are displayed on the Internet Explorer context 
menu. 
To hide or display the PROMT toolbar, select Toolbars in the View menu and select or clear the 
PROMT checkbox.  

3.3.1. Customizing PROMT for Internet Explorer 

To customize PROMT for Internet Explorer, select Customize Translation Options from the Tools 
menu or click the corresponding button on the PROMT toolbar. 
The Customize Translation Options dialog box has three tabs: 

• Translation 
• Commands 
• Menu (in IE7, this tab is available only if the Safe Mode is disabled) 

The Translation tab allows you to view and edit topic templates for the selected direction of 
translation. Click Edit Topic Templates. The Topic Templates dialog box will appear in which you can 
view the existing topic templates, create new ones or edit a template that you want to use during 
translation. For more information on how to work with topic templates, see Chapter 5. 
The Commands tab (Fig. 3.2) allows you to customize the PROMT for Internet Explorer options. 

 
Fig. 3.2. Customizing PROMT for Internet Explorer options 



 

The "Translate" command and "Translate page" command groups allow you to customize translation 
of the selected text or the entire page. If you enable the Show the translation in Translation pane 
mode, the program will display the translation in the translation pane in the lower part of the browser 
window. 
In Internet Explorer 7.0, you can view the translation of the entire page on a separate tab. To do this, 
enable the Show the translation in a separate tab mode in the "Translate page" command group. 
The "Search the Web" command group displays the options for showing the search results. 
The SmartURL group allows you to customize the following options for specified Web-addresses:  

• Remember translation options for each page option allows you to quickly and conveniently 
translate the Web pages that you visit regularly. The program saves the translation features of 
each Web page in the SmartURL database and uses them automatically when you translate 
these pages again. 

• To specify the URLs by particular translation features, click the Edit SmartURL button. You 
can specify addresses by clicking Add, Change and Remove. Select the direction of translation 
and the topic template for each URL. 

• The Recursive tunings checkbox applies the SmartURL translation features (saved 
automatically or specified manually) to all subpages on lower levels. 

• The Days to keep options in storage field allows you to specify how long you want the 
settings to be kept in the database (30 days by default). 

• The Clear Storage button clears the SmartURL database. 
In Internet Explorer 7.0, the RSS Translation group is added to the Commands tab. In this group, you 
can customize RSS channel translation. Click Customize RSS Translation, edit the list of RSS 
channels, specify the direction of translation and the topic template for each of them and click ОK. 
You can translate RSS channels by clicking the corresponding button on the toolbar.  
The Menu tab allows you to add commands to the Internet Explorer context menu: 

• Translate and Translate Page — enable translation of texts on the Internet. 
• Search the Web — enables you to create and translate a query for searching the Web. 
• Customize Translation Options — opens the window with the PROMT for Internet 

Explorer options. 
• Unknown Words permits you to view the list of unknown words in a separate pane in the 

left part of the browser window. You can save the words as a text file. 

3.3.2. Searching the Web 

To search the World Wide Web, select Search the Web from the Internet Explorer context menu, or 
click the corresponding button on the toolbar. The program will display a dialog box that permits you 
to create a query in any language, translate it, and send the translation to the selected search engine. A 
query can be Simple, Advanced or Professional. 

3.3.2.1. Simple Query  

The Simple Query tab allows you to translate and send to search engines one-word, several-word or 
one-phrase queries (Fig. 3.3). 



 

 
Fig. 3.3. Simple query 

To make a query: 
1. Type one or more words that will be the keywords for the search. Separate them with spaces. 
2. Specify the search options (search for all of the words, for any of them or for the exact 

phrase). 
3. Select the direction of translation, the topic template, and the search engine that will process 

the query. In the Composed query for the server field, you can see the translation of the query, 
which the program has created according to the rules of the selected search engine. 

4. Click OK to send the translated query to the search engine. 

3.3.2.2. Advanced Query 

The Advanced Query tab (Fig. 3.4) allows you to translate and send to search engines more complex 
queries, which contain several words or phrases. 



 

 
Fig. 3.4. Advanced query 

To create an advanced query: 
1. Enter the words or phrases that must/must not/can occur in the found documents in the 

corresponding fields. Select the Phrase checkboxes if the expressions that you enter are exact 
phrases. 

2. Select the direction of translation, the topic template, and the search engine that will process 
the query. In the Composed query for the server field, you can see the translation of the query, 
which the program has created according to the rules of the selected search engine. 

3. Click OK to send the translated query to the search engine. 

NOTE: 
The keywords that you entered earlier are displayed on the drop-down lists on the Simple Query and 
Advanced Query tabs. These lists are saved separately for each direction of translation. 

3.3.2.3. Professional Query 

The Professional Query tab intended for experienced users (Fig. 3.5). It allows them to translate and 
send any type of query to search engines. 



 

 
Fig. 3.5. Professional query 

This tab has some peculiarities: 
• You should create a query on your own by using brackets, quotation marks, and logical 

operators (AND, OR, NOT, +, -) that are recognized by the selected search engine. 
• There are no limitations to the number of phrases in the query. 
• You can edit the translated query. 
• To translate the query, click Translate. 

To create a query, type the query text, select the direction of translation, the topic template and the 
search engine, and click Translate. The query translation will appear. If necessary, edit the translation 
and click OK to send the query to the search engine. 
 

NOTE: 
You can use the Professional Query tab to edit the queries that you create when using the other two 
tabs. To do this, copy the translation from the Simple Query tab or the Advanced Query tab to the 
Clipboard and then paste it into the Translation field of the Professional Query tab. After you have 
finished editing, select the search engine and click OK. The query will be sent to the selected search 
engine. 

3.3.3. Translating Web Pages 

To translate Web pages directly in Internet Explorer, you can use two buttons on the PROMT toolbar 
and two corresponding commands in the context menu: 

• Translate (translation of the selected text) 
• Translate Page 

In both cases, the location of the translation depends on the settings (see Section 3.3.1). 
You can select the direction of translation and the topic template from the drop-down lists on the 
PROMT toolbar.  
The translation text preserves all formatting styles, links and pictures of the source text. To go to the 
next page, you can click on the links, either on the source page or on the translated page.  
To enhance the translation quality, you can attach or detach additional dictionaries, add words and 
collocations to the list of preserved words, enable transliteration of unknown words, attach 



 

preprocessors, and use the translation rules. To customize these options, click Edit Topic Templates in 
the Customize Translation Options window. 
See Chapter 5 for more information on how to work with topic templates. 



 

3.4. PROMT for Mozilla Firefox 

PROMT for Mozilla Firefox enables translation of text and search engine queries in Mozilla Firefox. 
To embed the translation functions in Mozilla Firefox, select the corresponding checkbox in the 
PROMT Extensions Manager dialog box (see Section 3.2). 
This will add the PROMT menu to the user interface of the application. The menu has translation 
commands and translation options. The main commands are displayed in the Mozilla Firefox context 
menu. 
To hide or display the PROMT toolbar, select Toolbars from the View menu and select or clear the 
PROMT checkbox. 

3.4.1. Customizing PROMT for Mozilla Firefox 

To customize the translation options, click Options in the PROMT toolbar and select one of the 
following commands: 

• Edit Topic Templates opens the Topic Templates dialog box, in which you can view the 
existing topic templates, create new ones or edit a template that you want to use during 
translation; 

• Show Translation Results in a New Tab displays the translation of a page on a new tab; 
• Show Search Results in a New Tab displays the search results on a new tab. 

3.4.2. Searching the Web 

To search the World Wide Web, select Search the Web from the context menu, or click the 
corresponding button on the toolbar. The program will display a dialog box that permits you to create 
a query in any language, translate it, and send the translation to the selected search engine. The queries 
can be subdivided into simple, advanced, and experienced. To make a query, you should follow the 
same steps as in Internet Explorer. You can find the description in Section 3.3.2 and in Help. 

3.4.3. Translating Web Pages 

To translate Web pages directly in Mozilla Firefox, you can use two buttons on the Translator toolbar 
and two corresponding commands in the context menu: 

• Translate Selected Fragment (translation of the selected text) 
• Translate Page 

In the first case, the translation is placed in the pane at the bottom of the browser window. 
In the second case, the program translates the entire page and either places the translation on a separate 
tab or replaces the current page, according to the settings that are described in Section 3.4.1.  
You can select the direction of translation and the topic template from the drop-down lists on the 
PROMT toolbar.  
The translated text preserves all formatting styles, links, and pictures of the source text. To go to the 
next page, you can click on the links, either on the source page or on the translated page.  
To enhance the translation quality, we recommend that you customize translation according to the text 
topic. Use the Topic Templates dialog box to edit the existing topic template or create a new one, save 
it, and translate the text again.  
See Chapter 5 for more information on how to work with topic templates. 



 

3.5. PROMT for Acrobat 

PROMT Plug-In for Acrobat engine enables translation in Adobe Acrobat and Adobe Acrobat Reader. 
This application provides translation of the selected text in a separate window. It does not preserve the 
formatting features of the source text. 
To embed the translation functions in Adobe Acrobat (Reader), check the corresponding checkbox in 
the PROMT Extensions Manager dialog box (see Section 3.2). 

NOTE: 
To embed the translation functions, you need to have the administrator rights (i.e., your account must 
belong the Administrators local group). 

This will add the PROMT submenu to the Adobe Acrobat or Acrobat Reader Plug-ins menu. The 
submenu has translation controls. 

3.5.1. Translating Text 

To translate a text fragment in Adobe Acrobat (Acrobat Reader): 
1. Choose the direction of translation and the topic template by selecting Plug-Ins →  PROMT 

and then Direction of Translation or Topic Template, respectively. 

2. Select the text that you want to translate. 

3. Select Plug-Ins →  PROMT →  Translate, or click the corresponding button on the toolbar. 

The translation will appear in the Translation window. The program does not retain the formatting 
features of the source text. You cannot edit the translation in this window. You can use the Translation 
window toolbar buttons to copy the translation to the Clipboard, change the font or the background 
color. 
 
To enhance the translation quality, you can attach or detach additional dictionaries, add words and 
collocations to the list of preserved words, enable transliteration of unknown words, attach 
preprocessors, and use the translation rules. To customize these options, click Plug-Ins →  PROMT →  
Document Topic →  Edit Document Topic and make appropriate changes on the corresponding tabs of 
the Document Topic dialog box. 
For more information on how to work with dictionaries and topic templates, see Chapters 4 and 5, 
respectively. 



 

 

3.6. PROMT for ICQ  

PROMT for ICQ allows you to translate messages in the ICQ program by using the customizable 
keyboard shortcuts. 
To start the program, select Start →  All Programs →  PROMT →  PROMT for ICQ.  
After starting, the application appears as an icon on the taskbar. If you right-click the icon, you will 
see the context menu commands that allow you to customize the program options and the translation 
options, view the program properties and access Help. 

3.6.1. Customizing PROMT for ICQ  

The dialog box for customizing the program appears when you first launch it. Later, you can open it 
by selecting Customize from the context menu. 
You can customize the following options: 

• Specify the keyboard shortcut for translating the text and the keyboard shortcut for selecting 
the direction of translation and the topic template. To do this, click the mouse in the 
appropriate field and press the desired keyboard shortcut. 

NOTE:  
The keyboard shortcuts Ctrl+Shift+A, Ctrl+Shift+I, Ctrl+Shift+C, Ctrl+Shift+E, 
Ctrl+Shift+F3, Ctrl+Shift+F, Ctrl+Shift+S, Ctrl+Shift+W, Ctrl+Shift+D are already used in 
the ICQ program and cannot be used by the PROMT for ICQ application. 

 
• Choose the convenient sequence of actions during translation: first select the text and then 

press the keyboard shortcut, or first press the keyboard shortcut and then point at the text with 
the mouse and click on it. 

• Specify where to place the translated text. The program can replace the source text or show the 
translation in a separate window. 

NOTE: 
If you select the Press the shortcut key and point the text with the mouse option, the translation 
can be shown only in a separate window. You will see the translation of the outgoing message 
or all received messages from the upper part of the ICQ window.  

 
• Enable or disable starting the application whenever Windows starts. 

3.6.2. Customizing Translation in PROMT for ICQ 

To select the direction of translation and the topic template, press the keyboard shortcut that was 
specified on the previous step, or choose the Select the Direction of Translation command of the 
context menu. 
The Edit Topic Templates command in the context menu opens the Topic Templates dialog box in 
which you can view the existing topic templates, create new ones or edit whichever topic template you 
want to use during translation. 
For more information on how to work with topic templates, see Chapter 5. 



 

3.6.3. Translating in PROMT for ICQ  

You can use PROMT for ICQ for translating both the outgoing messages and the received ICQ 
messages. In the latter case the translation of the received messages can be shown only in a separate 
window. 
 
To translate a message, follow these steps: 

1. Customize the program, as described in Section 3.6.1. 
2. Select the direction of translation and the topic template (see Section 3.6.2). 
3. Depending on the chosen sequence of actions: 

 Select the text fragment and press the keyboard shortcut for translation. 
 Press the keyboard shortcut for translation (you will see two-directional arrows under the 

mouse pointer), point at the text for translation, and then click the left mouse button. 
The program can replace the source text with the translation or show the latter in a separate window. 
The translation in a separate window does not have the formatting features of the source text and 
cannot be edited. You can copy it to the Clipboard and then paste where necessary. 
 



 

Chapter 4. Dictionaries 
This chapter describes how to use, create, save, and attach different types of dictionaries of the 
@promt Personal 8.0 system.  

4.1. Types of Dictionaries 

One of the ways to improve the translation quality when working in @promt Personal 8.0 is by editing 
and adding data to dictionaries. 
There are three types of dictionaries: 

• General dictionaries 

• specialized dictionaries 

• user dictionaries 

Dictionaries contain translations of words and collocations, along with grammatical information that is 
necessary to obtain coherent text translation. A dictionary consists of dictionary entries. 

4.1.1. General Dictionaries 

The General dictionaries are supplied with the @promt Personal 8.0 software product. Each direction 
of translation has its own General dictionary. Thus, there are as many General dictionaries in your 
product as there are directions of translation installed.  
The General dictionaries contain common vocabulary, including multifunctional and syntactic words 
(collocations), which build the sentence structure. Without attaching specialized dictionaries, the 
General dictionaries can be used to translate personal letters, newspaper and magazine articles on 
popular topics, as well as simple fiction texts. 
The General dictionaries cannot be viewed or edited by the user. 

4.1.2. Specialized Dictionaries 

Specialized dictionaries are intended to improve the quality of translation of texts in a specific subject 
area. Some specialized dictionaries are included free of charge in your @promt Personal 8.0 product. 
Other specialized dictionaries can be purchased separately, or as collections of dictionaries for specific 
subject areas. 
Specialized dictionaries can be installed or removed only in the PROMT Dictionary Installer 
application (see Section 2.3). 
Attaching or detaching specialized dictionaries enables you to customize the @promt Personal 8.0 
system for translation of texts on specific subjects. During translation, the program first looks for 
translations of the words and phrases in the attached specialized dictionaries, and then in the General 
dictionary, which has the lowest priority. 
Specialized dictionaries not only provide correct translation of particular words and collocations from 
specific subject areas, but also improve the overall quality of the translation because they contain 
comprehensive information about the typical sentence constructions of a subject area.  
Specialized dictionaries cannot be edited by the user. 

4.1.3. User Dictionaries 

You can create your own user dictionaries to enrich the program's vocabulary and to fine-tune the 
translation in specific subject areas. User dictionaries can be supplemented and edited. If you are 



 

dissatisfied with the translation of a word (collocation) from the General or a specialized dictionary 
and would like to edit the entry, you can save the changes only in a user dictionary. 
Creating user dictionaries is helpful for translation of large documents, or a number of small 
documents on the same topic. 
When working with the user dictionaries, you can: 

• attach or detach user dictionaries;  

• change the priority of user dictionaries; 

• delete user dictionaries; 

• save user dictionaries to an archive file; 

• load user dictionaries from an archive file. 

4.1.4. User Dictionaries of Previous Versions 

User dictionaries that were created in the previous versions of @promt software products can normally 
be loaded into @promt Personal 8.0. However, dictionaries of previous versions cannot be converted 
automatically in some cases because of considerable differences in the structure and format of the 
current and earlier versions. In such cases, you should consult the PROMT technical support team. 
Generally, dictionaries of the @promt Personal 8.0 system are not compatible with previous @promt 
versions. 



 

4.2. General Principles of Managing Dictionaries 

A dictionary of the @promt Personal 8.0 software product is an object with the following properties: 
• title (header); 
• copyright information; 
• comments; 
• protection information. 

The location of dictionary files in the file system is not revealed to the user. A dictionary may be 
represented as a file only when it is saved to a dictionary archive (a file that has the *.adc extension). 
A dictionary archive file can be used to provide a backup copy or to copy a dictionary from one 
computer to another. 
If you load a dictionary from a dictionary archive file, all changes that you make to the dictionary will 
have no effect on the dictionary archive file until you save that dictionary to the dictionary archive file 
(by using the Save to dictionary archive command). 
The dictionaries from the dictionaries list are always available in the translation system and can be 
used for translation at any time.  

4.2.1. List of Dictionaries 

There is a general list of user and specialized dictionaries for every direction of translation.  
You can view the list of dictionaries on the Dictionaries tab of the Document Topic dialog box or of 
the Topic Templates dialog box (see Chapter 5).  

4.2.2. Attaching Dictionaries and Changing Their Priorities 

To attach a dictionary means to select it for translation. The priority of a dictionary is determined by 
its position in the list of attached dictionaries for a given direction of translation. During translation, 
the program looks up the words in the dictionaries according to their order on the list. The General 
dictionary has the lowest priority. 
We recommend that you attach only those dictionaries that are required for translation of the current 
text. Attaching a large number of dictionaries may affect the translation quality. 
In all @promt Personal 8.0 applications which are intended for translation, you can attach or detach 
dictionaries and change their priority on the Dictionaries tab of the Document Topic dialog box or of 
the Topic Templates dialog box.  
To attach a dictionary, select it from the list of unattached dictionaries and click on the Right arrow, or 
select Attach from the context menu. 
To detach a dictionary, select it from the list of attached dictionaries and click on the Left arrow, or 
select Detach from the context menu 

NOTE: 
The General dictionary is not displayed among the attached dictionaries, but is always attached for 
each direction of translation. 

To change the priority of a dictionary, select it from the list of attached dictionaries and use the arrows 
on the right of the list, or the Move Up, Move Down, Move to Top commands on the context menu. 

4.2.3. Creating User Dictionaries 

To create a new user dictionary for the current direction of translation, select the Dictionaries tab of 
the Document Topic dialog box or of the Topic Templates dialog box, click the right mouse button in 
the field of any list of dictionaries, and choose New in the context menu.  
The Dictionary Properties dialog box will appear. In this box, you should do the following: 



 

1. Enter information about the new dictionary. Specify the dictionary title (15 characters 
maximum). The Copyright and Comments fields are optional. 

2. If you want to specify the password, click Protection (if not, proceed to Step 4).The 
Dictionary Protection dialog box will appear. 

3. Select Protect the dictionary with the password. Enter the password in the Password field (not 
more than 8 symbols). Confirm the password by entering it again in the Confirm password 
field and click OK. The password is set and you will return to the Dictionary Properties dialog 
box. 

4. Click OK. 
You can edit the new dictionary and attach it to translation. 

4.2.4. Saving, Loading, and Deleting User Dictionaries 

Loading from an archive and saving to an archive are operations that are used mainly to transfer data 
between different computers or to provide backup copies.  
To save a dictionary to an archive file, right-click in the dictionary list window and select Save to 
Dictionary Archive from the context menu. 
To load a dictionary from an archive file, right-click in the dictionary list window and select Load 
from Dictionary Archive from the context menu. 
The translation program does not permit you to have dictionaries with identical names within one 
direction of translation. Therefore, if there is a dictionary in the system that has the same name as one 
loaded from an archive, the program will prompt you to rewrite it, or to load it under a different name.  
If you try to load a password-protected dictionary taken from a different computer, the program will 
ask you to enter the password.  
To remove a selected user dictionary, click Delete in the dictionary list window. The Deleting the 
dictionary dialog box will appear, where you can choose to save the selected dictionary to a dictionary 
archive file before deleting it. 

4.2.5. Trial Dictionaries 

Trial dictionaries are dictionaries that have a limited period of use. They are intended for evaluation 
purposes only. After installation, trial dictionaries are marked by a special icon, to make them easily 
distinguishable from other dictionaries on the list. The trial dictionary properties window shows the 
period of use of a dictionary. When the period ends, the program deletes the dictionary automatically. 



 

Chapter 5. Topic Templates 
When translating documents, it is often necessary to save all translation options for texts on various 
topics. To do this, you can use combinations of translation settings called topic templates. 
The topic template includes the following basic properties available in all @promt Personal 8.0 
applications: 

• the list of attached dictionaries (with priorities); 
• the list of preserved words; 
• the list of attached preprocessors (with priorities); 
• the list of translation rules; 
• the enabled or disabled feature of transliterating unknown words; 
• the enabled or disabled feature of displaying translation variants. 

During the installation, a general topic template named General is created. This topic template 
includes only the General dictionary (always attached) and cannot be deleted or renamed (although it 
can be modified).  

5.1. Main Operations with Topic Templates 

The topic template functionality is provided by the @promt Personal 8.0 system kernel. This means 
that all operations with topic templates in different @promt Personal 8.0 programs are identical. 
Changes made with topic templates in one application are visible in others. 
You can perform the main operations with topic templates in @promt Personal 8.0 applications in the 
Topic Templates dialog box (Fig. 5.1).  

 
Fig. 5.1. The main dialog box for creating and editing topic templates 

In the applications with translation functions, you can open the Topic Templates dialog box by using 
the Edit Topic Templates command. 



 

The Topic Templates dialog box allows you to create a new topic template; edit, rename or remove an 
existing one; load a template from the archive; or save to the archive. After closing the dialog box by 
using the OK button, all changes are automatically saved. They will become effective when you open 
a document in this template. 

5.1.1. Creating a New Topic Template 

1. In the Topic Templates window (Fig. 5.1), select New Template. The New Topic Template 
dialog box will appear. 

2. Enter the name for the new topic template in the Title field and specify how you want to create 
it: 
 Empty - the template will be created anew; 
 On the basis of the selected topic template - the new template will be based on an existing 

template and will initially have its properties. 
3. Click OK. You return to the dialog box where you can form the new topic template structure. 

5.1.2. Editing a Topic Template 

You can use the Topic Templates dialog box to customize translation options.  
In the Topic Templates dialog box (Fig. 5.1), select the template that you want to edit.  
By using the tabs of this dialog box, you can: 

• attach dictionaries to translation and specify their priorities, or detach dictionaries; 
• create a list of preserved words; 
• attach preprocessors; 
• customize translation rules; 
• enable or disable the feature of transliterating unknown words; 
• enable or disable the feature of displaying translation variants. 

5.1.3. Renaming a Topic Template 

1. In the Topic Templates dialog box (Fig. 5.1), select the topic template and click Rename. 
2. In the Rename Topic Template dialog box, enter the new name in the New title field.  
3. Click OK.  

The renamed topic template will appear on the list. 

NOTE: 
You cannot rename the General topic template. 

5.1.4. Deleting a Topic Template 

In the Topic Templates dialog box (Fig. 5.1), select the template and click Delete. 

NOTE: 
You cannot delete the General topic template. 

5.1.5. Saving a Topic Template to an Archive  

Topic templates can be saved to archives and then restored on the same, or a different, computer. 
When saving a topic template, you can, if you wish, save the attached user dictionaries.  



 

1. In the Topic Templates dialog box (see Fig. 5.1), select the template (to select more than one 
template, use Ctrl or Shift). 

2. Click Archive and select Save to Topic Template Archive from the drop-down list. 
3. Enter the name of the archive file in the Save dialog box.  

NOTE: 
When saving a group of topic templates, the system will prompt you to specify the folder where you 
want the archives to be saved. 

5.1.6. Loading a Topic Template from the Archive  

In the Topic Templates dialog box (see Fig. 5.1), click Archive and select Load from Topic Template 
Archive. In the Load dialog box, select the archive file. The translation program does not allow you to 
have topic templates that have identical names within one direction of translation. If you attempt to 
load a template from an archive and there is already a template under the same name in the system, the 
program will prompt you to rename the existing template or to load the template with a different name. 

5.2. Document Topic 

The document topic is a combination of the document translation settings. It is based on the topic 
template that you select when creating or opening a document. It is used to customize the system for 
translation of a specific document.  
You can customize the document topic in PROMT Editor Lite and in Adobe Acrobat with embedded 
translation fucntions.  

5.2.1. Editing Document Topic 

You can edit the document topic in the Document Topic dialog box (Fig. 5.2), which you can open by 
using the Edit Document Topic command. 

 
Fig. 5.2. Dialog box for editing document topic 



 

By using the tabs of the Document Topic dialog box, you can perform the following: 
• attach dictionaries to translation and specify their priorities during translation, or detach them 

from translation; 
• create a list of preserved words; 
• attach preprocessors; 
• customize the translation rules; 
• enable or disable the transliteration of unknown words; 
• enable or disable the displaying of translation variants. 

5.2.2. Saving a Document Topic to a Topic Template 

When you close a document or select another topic template, all current settings are lost. If you want 
to use them later, you should save them as a topic template.  
To do this, click Save as Topic Template in the Document Topic dialog box.  
In PROMT Editor Lite, you can select Save as Topic Template in the Document Topic group on the 
Translation Options tab. The program prompts you to overwrite the existing topic template, or to save 
the document topic to a new topic template. 


